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What is Dreamweaver?

Dreamweaver CS3 is a powerful Hypertext Markup Language (HTML) editor used by
professionals, as well as beginners. The program makes it easy for designers to create visually
attractive, interactive Web pages without having to know HTML or JavaScript. However,
Dreamweaver CS3 enables the experienced professional to write and edit HTML using the code
editor. Dreamweaver also gives the opportunity to create web pages and learn HTML coding as
you go along, by giving you the option of a split screen with code and design.

If your department doesn’t already own a copy of Dreamweaver, you may talk to your IT
Department about downloading a free 30 day trial from the Adobe website at
http://www.adobe.com/products/dreamweaver/ .

Before you start with Dreamweaver.

There are a few things that need to happen before you start your web page in Dreamweaver.

The very first thing you need to know is your audience. Who is your target audience? What
will they be looking for in your website? Will they be looking for entertainment, information,
or education? What type of equipment do they use?

When you have that information, you need to plan out your website. What information will go
on the home page? How many pages will your site have? How will you navigate around the
pages? One of the best features about a web site is that they are not linear, but hypermedia.
Websites are like a CD compared to an audio tape. They can be accessed in different
sequences depending on what each person is looking for in your website. What images or
other objects will you want included in the site? A good way to lay all this out is to use sticky
notes and lay them out to see how your site will flow, and what your layout will be. You may
then want to create a flow chart that will show how your pages will be linked.

Next, gather all your content, such as any documents, images, movies, scripts, etc that will
Once you have this information, you can begin to create your site by setting up the folders you
will need for the site. Start with the root folder (the site folder) and everything else will need
to go in this one folder. Even a small site must have a root folder and should also have an
images folder and maybe even a content folder. Larger sites may have those folders and then
go on to add other subfolders for each section of the web site. Each website must have its
own root folder.

Because some browsers read text case sensitive it is a good idea to have all your file names
in lower case letters. To make them more readable it is acceptable to use the underscore _ to
separate words in your names. It is best for your home page to be named index.htm.
Each website has a unique address or URL (Uniform Resource Locator). A browser will
recognize index.htm as the home or opening page of your website. It is possible to locate a
home page with alternate names, but the URL would have to be typed out including the home
page name, including the file extension. In other words, to locate the home page named
index.htm you would type in an address of http://www.website.com. But if your home page is
named mysite.htm, you would have to type http://www.website.com/mysite.htm. This is not
imperative, but using the index file will make it more easily accessible to others. Also
Dreamweaver automatically recognizes index.htm and you do not have to go through an extra
step to designate the page as your home page.
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HTML — Hypertext Markup Language

HTML is a set of codes that describe the appearance of web documents and all the objects on
the page. Objects could be anything from text to images to movies. The HTML codes are
called tags. The tags are enclosed with the < and > symbols so the programs reading them
recognize that they are tags. Most items have an opening tag < > and a closing tag < />.
For example <title> This is the title </title>. The tags signify the beginning of an item and
the end of that item. Each item is called an element. Each element can have attributes and
the attributes can have values. Values follow an equal sign and are in quotes. HTML tags are
not case sensitive, so it doesn’t make any difference if you use upper or lower case letters,
however lower case is the norm.

<ELEMENT ATTRIBUTE= “VALUE”> or, think of it this way:

<CAR MODEL="CAMRY” COLOR= “RED”>
<SANDWICH BREAD="WHEAT”">

All HTML documents are required to have certain elements.
<html> This designates the beginning of the document.

<head> This section contains the document title, keywords, meta tags, scripts
<title> Document title </title>
</head> This is the end of the Head section

<body> This designates the beginning of the Body section
All the content of the page would be in the body section
</body> This is the end of the Body section

</html> This is the end of the HTML document

The World Wide Web is overseen by a not for profit group called the W3C (World Wide Web
Consortium). They have hundreds of members from many countries and many companies.
They are dedicated to providing Interoperability on the web so everyone has equal access to
the web. From the W3C website:

The World Wide Web Consortium (W3C) is an international
consortium where Member organizations, a full-time staff,
and the public work together to develop Web standards.
W3C's mission is:
To lead the World Wide Web to its full potential by
developing protocols and guidelines that ensure
long-term growth for the Web.
http://www.w3.0org/Consortium/Overview

One free online site that provides many tutorials with cut and paste examples is W3 Schools at
http://www.w3schools.com/

A few common tags are:

<p> paragraph <br> line break <td> table data
<hr> Horizontal Rule (line) <H1> Heading 1 <img> image
<a> anchor <a HREF > link &nbsp non-breaking space
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File Size, Download Time and Screen Resolution

A couple of other items that need to be mentioned are download time and screen resolution.
The web site you are creating is meant for viewing. To make it as accessible as possible it is a
good idea to limit the amount of information on each page. Most viewers will not wait more
than 8 seconds for a page to load. Larger files take longer to download. If it takes too long,
they will just go somewhere else. The pages may need to be divided up into more pages with
less information or images on each page or the images may need to be optimized (smaller file

size) for the web.

There are various size monitors and many have different resolutions. Resolution (for

monitors) has to do with the number of pixels (colored squares) across and down the screen.
Today’s monitors can be set to various resolutions. Some older monitors are set for a page

resolution of 640 pixels wide x 480 pixels high. Currently many monitors are set to a

resolution of 800 x 600 or, like the monitors in the training room, 1024 x 768. Viewers do
not like to have to scroll side to side so some website developers limit the page size to less

than 800 pixels, usually 760 pixels to be safe. Before creating your web site you need to
determine who will be viewing the site to decide the page size you want to use. To be

absolutely safe you may still want to create pages for the 640 pixel wide pages. When you

are choosing images for your web site, look at the pixel dimensions of the image. For

example a digital camera may take a picture that is 3000 pixels wide. To put that image on a
web site that image would have to be downsized quite a bit to fit on a page. Use a graphics
program such as Photoshop or Fireworks to optimize your images. You want to create them to
the proper size outside of Dreamweaver and then bring them into your web site at the proper
screen size and the smallest file size.

Accessibility

To keep in line with Accessibility
guidelines and regulations,
Dreamweaver has some
“helps” that you can use to
remind you to add certain
properties and attributes to
make your pages more
accessible to those with visual
or other disabilities.

From the Edit menu choose
Preferences to get the box
shown on the right.

Then click on the Category
called Accessibility.

By default the four top
checkboxes are checked. If
these are not checked, check
them. When you are creating
your web pages Dreamweaver
will automatically open dialog
boxes to allow you to add
accessibility options and will
alter your code appropriately.
The other two check boxes do
not alter the code, but change

how the program works, so these can be left as
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Cateqory Accessibility

General

O Elente Show attributes when inserting:
Cade Calaring IV Eorm obiects
Code Format

Code Hints V' Frames
Code Rewriting ¥ Media
Copy/Paste o

55 Styles W' mages

File Compare

File Types | Editors
Faonts

Highlighting
Invisible Elements
Lavout Mode

New Document
Presiew in Browser
Site

Status Bar
Yalidator

" Keep fiacus in the panel when opening

¥ offscreen rendering (need to disable when using screen readsrs)

Help |

OK I Cancel
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Dreamweaver CS3 Start Page

Open existing pages
Create new sites or pages

Get to the Online Help Page

ADOBE" DREAMWEAVER® CS3

Open a Recent ltem Create Ne: Create from Samples Netwaork

&5 open -\j HTML m CSS Style Sheet FTP &RDS Servers
U CaldFusion -Iﬂ Frameset Desxiop items
5 pe T Starter Page (Theme)
T AsP vBSeript 7] Starter Page (Basic)
T SLT (Ertire page) 3 Mare
) ess
T JavaScript Extend
T @) Dreamweaver Exchange »
gp Dresmweaver Site...
H‘j More...
L] Getting Started » Adobe Developer Connection - New
l:| Mewy Festures » m Technical content, code, and community,

[:| Resources »

Start Page - Welcome Screen

This is the page you get when you first start up Dreamweaver CS3. This gives you
the option to open many different kinds of pages. The start page can open each time
you start Dreamweaver or it can be disabled by checking the Do not show again box.
If you decide later you want it back go to Edit = Preferences > General and check
the Show start page option.

From the Welcome Screen you can choose Create New to open new blank pages. Or

go to Create from Samples. This area gives many sample web site designs that
you can use and customize for your own web site.

8 8/27/2008



The Dreamweaver CS3 Designer Workspace

Menu Bar

M Adole Dreamweaver C53 - [Untitled-2 (XHTML)]
Eile EdiMq View [nset Modify Ted Commands Site

» Application

Insert Bar

P Tag Inspector

¥ Files

Open documents -8x
it & |_5|v &, % R checkPage

|
B Desktop - | Manage Sites

Local Files | size[typ
= Bl Desktop

(- Computer

¥ Netwark

-..BB FTP &RDS Servers

--IZ) Desktop items

Document Window

§5 This area displays the current document
as you create and edit it.

You can type right in this area and Dreamweaver
will write all the necessary code in the
background for you. 'l

Panels can be collapsed or expanded by
clicking on the expander arrow.

3
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| /

=

g

<body > &% Q [100% + | 763x 415+ 1K/ 1sec

Font DefaultFont «  Size [0d ~ ’i =
Page Properties... List Item... N -

[ 3
&

®
-oo

) ~

Property Inspector

This is the new Designer layout of the Dreamweaver CS3 where the panels are docked on the right
side. There is also an alternate Coder workspace that is similar to the HomeSite/Coder-Style
workspace for those that prefer to do most of their web page creating in the HTML code view. This
can be changed at startup or by choosing Change Workspace in the Preferences area under the
Edit Menu.

The only choice in the Macintosh is the “floating” style workspace where each panel is separate.
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The Insert Bar

ﬂ Adobe Dreamweaver C53
File Edit View Inset Modify Text Commands 5ite Window Help

AU Common Forms

Insert Bar — This is used to Insert components in your web page.

Click icon to add images, links, forms, create layouts. All items on the
Insert Bar can be found on the Insert Menu, but it is usually easier to use
the buttons on the Insert Bar.

Each Category offers different object to add to your page.
Click on each tab (category) to see the different options.

The Common category shown above holds the most commonly used
choices, such as images, tables, links and media.

m Adobe Dreamweaver C53 - [Untitled-2 (XHTML)]
File Edit View 1 Text Commands 5Site  Window Help

¥ Insert  Commoi @ 5

Favorites

._._.._':; Er| 'El s

This is the Layout category. This gives options for laying out the
web page. In Standard mode, tables can be inserted by rows and
columns looking like they would in a browser. Expanded mode
temporarily adds cell spacing and padding so editing will be easier,
but does not appear as the table would in design view.

In Layout mode Dreamweaver CS3 allows you to draw a table and
individual table cells for the layout of your page.

File Edit View Inset Modify Texdt Commands Site Window Help

¥ Insert  Common Spry Favorites

B 7| S em|q (»9e|hl h2 h3| ul of K |dl dt dd |ebee wac| P -

Each category has a group of items each with buttons to let you add or edit objects or text.
The Text category allows insertion of text and paragraph formatting tags.

The Forms category includes items such as text field, radio buttons, and list menus.

The Favorites tab can be customized to the items you use the most.

< 09 a||995x419£b
i ¥ |

The left side of the document Status Bar has a Tag Selector. This allows you to select
an item by clicking on the tag.

The right side of the status bar gives information about the document, including the size /
of the document window and approximate download time. Dreamweaver uses a 28.8
modem speed as a default. This can be changed in the Preferences area under the Edit
menu. This area has a new zoom tool to help focus on complex design areas.

The Status Bar
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The Document Toolbar
The Document Toolbar is where you can change your document window views

Code shows HTML code only
Split shows both the design view and the code view
Design shows only the design view (similar to the way a browser sees the page)

Untitled-3

i o] code |L‘_,jj5plit @Designl Title: | Untitled Document ){L'n', &, ‘ - E B, ‘ B 24 Check Page

N - \
Click here to view your page

in a true browser or use the
Enter your page title here. The page title and the Shortcut F12
file name do not have to be the same.

_ (8] x|
i Design
ik Code
i Application

Docked Panels

i P Tag Inspectar

i

ii ¥ Files

Iﬁ TrialSite 7| |Local view x|
HC|L e Y4B

Files Panel = @ Site - TrialSite (' \\Web Site! Trials
(similar to Windows Explorer) =5 css

. . - @ colorsS,css
Files (such as images) can be Ef@ Images

dragged to the document window to P E arainbackground psd

be added to the page. i
e @ Pinkarain. jpg

..... T Pinkérain,psd
[ toyshiur.jpg

= 'Eal kw

| k] ~e0 %
Iargetl 'I

[F'age Prnperties...” List Tterm. ., I

it ¥ Propetties
EcurmatIF'aragraph j StxleINnne j ca | B‘I ‘_

antIGE:u:urgiaJ Times j §ize|30 j % ju

—| =
i=|:=

[F

|
[F

The Property Inspector is context sensitive. It changes for each object or text item,
and shows the attributes for that item. It gives an easy way to view and edit the
properties of each item. The expander arrow will expand or collapse the property
inspector to show or hide properties. Any time the property inspector is not visible, go to
Window > Properties on the Menu bar.

Another feature of Dreamweaver CS3 is the right-click context menu. When you are
working on an item a right-click will bring up a menu with the most useful commands and

properties related to that particular item.
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Starting the Web Site

The first step in building a web site in Dreamweaver is to define the site. At this point, the
site is already planned on paper. Now, create the folders and sub folders on the hard drive.
You want to have something similar to folder below, where gainesville_site is the root folder
and content and images are your subfolders. If you have all your images and content
gathered, it is best to put it all in the proper folders at this time. Now we can define our site
with Dreamweaver by specifying what the names of the folders are, and where they are

located.
& gainesville_site 1Ol x|
File Edit View Favorites Toaols  Help | ",'
\_,-" Back - \_/J - ﬂ' /-. ) search Folders =

address I gainesville _site

EBE

/J content
/J images

To define your site in Dreamweaver:
Open Dreamweaver CS3.

Click New.
Choose Site.

PONPE

When the site definition dialog box opens choose the Advanced tab.

Go to the menu and choose Site = Manage Sites.

(The basic tab will work, but it has more options than we need at this time.)

Site Definition for Unnamed Sikte 1

Basic Advanced I

Cakegory Local Info

Local Info
Rermoke Info

Testing Server
Cloaking

Design Mokes
Sike Map Layout
File Wiew Columns
Conkribuke

Local rook Falder

Sike name:

Defaulk images Falder:

_Innarne:

8 | v My Documnents\Dreammeaver ZSSpre | ()

Iv Refresh local file list aukomatically

i

Lirks relative to:

HTTP address:

Case-sensitive links:

Cache:

' Document ¢ Sike rook

| ke gy

This address is used For site relative links,
and For the Link Checker to detect HTTP
links that refer ko wour own site

I Use case-sensitive link checking

¥ Enable cache

The cache maintains file and asset
information in the site. This speeds up the
Asset panel, link management, and Site
Map features.

Ok I Cancel

Help

12
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5. Choose Local Info.

6. In the Site Name Text box, type the name of your website (i.e. Gainesville).
7. In the Local Root Folder area, click on the folder icon. Navigate to where your root

folder is stored. You should see the contents of your root folder

Choose local root folder for site gainesville:

H o2

8 [N

2|

@content
@images

My Documents

™

My Computer

Select: gainesville_site

Cancel

8. Click on Select.

9. Make sure Refresh Local File List Automatically and Enable Cache are checked.

(Unless you are working on a very large site, then uncheck Enable Cache)

10. Click OK. Click OK if the “initial cache” message pops up.

11. Click Done.

Creating the Home Page
Begin by creating a new page

1. From the menu, choose File = New.
a. Or use the Start Up page and Choose New HTML page

2. Choose a Blank page and HTML then click Create.

Mew Document

Page Type:

HTML

HTML template
Library item

XSLT {Entire page)
XSLT {Fragment)
ActionSeript

C55

Javascript

XML

I% Blank Page

tb Blark Template

i

Iib Page from Template

Ej Page from Sample

r Other

BEEEEEEEIE

ASP JavaScript

ASP VBScript
ASP.MET C#

ASP.MET VB
ColdFusion

ColdFusion component
15P

PHP

Help ] [ Preferences...

Layout:
<none
1 column elastic, centered
1 column elastic, centered, header and
1 column fixed, centered
1 column fixed, centered, header and 1
1 column liquid, centered
1 column liquid, centered, header and {
2 column elastic, left sidebar
2 column elastic, left sidebar, header a
2 column elastic, right sidebar
2 column elastic, right sidebar, header
2 column fixed, left sidebar
2 column fixed, left sidebar, header an

2 column fixed, right sidebar

2 column fixed, right sidebar, header a
2 column hybrid, left sidebar

2 column hybrid, left sidebar, header a
2 column hyhrid, right sidebar

2 column hybrid, right sidebar, header
2 column liquid, left sidebar

2 column liquid, left sidebar, header an

2 column liquid, right sidebar
4 | (1] | [

Get more content. ..

| »

HTML document

DocType:
Layouk 255:

Attach CS5 file:

<Mo preview >

X¥HTML 1.0 Transitional

Add to Head

& 0

Create Cancel
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The next thing you do is save your page. It may look like an empty page, but if you
look at the code view, you will see there is already information about your page. Use
either File=Save or CTRL + S. On the open document tab if a * is showing it
means the page has not been saved since changes have been made. It is always best
to save your work continually as you go along. Remember this will be the home page,
so we want the file to be named index.html. The best practice is to name your files
using all lower case letters with no special characters except the underscore () and
no spaces.

savens 21|
Save jne [ 5 gainssvile_sits = 9 iem
| hcontent
| iimages
File hame: Imdex j Save I
Saveaslipe:  [All Documents (him? btml.” shim:* shiml” hta; ¥ | Carcel |

2

In the Document Toolbar type the title of your web page. Call this Gainesville
Home Page or My Home Page. Unlike filenames, the title can contain spaces and/or
characters. Use a unique and descriptive title for your page. This title shows on the
blue title bar when you are viewing the page on the web.

Press Enter to apply the title to your home page.

This page will have a table in it to organize information. Tables are set up with rows
going across the page and columns going down the page. Cells make up the table and
have properties called cell spacing which is the space between each cell and cell
padding which is the space from the cell wall to the information placed inside the cell.
Go to the Common Category of the Insert bar. Choose the Table button.

When you choose the table button the Table dialog box pops up. Enter the number
of rows (4) and columns (2).

x
Table size
Raows: |4_ Columns: IZ_
Table width: W Ipercent 'l

Border thickness: IU pizels
Cell padding: |5
Cell spacing: IU

Header

[1T]
ann

= -

Top Bath
Accessibility
Capkion: |
Align caption: Idefault 'l
Surmmary: ;I
E
Help | [8]4 I Cancel |
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5 rows

If you do not want a Border to show, you would enter O in the border text box. For
this project we will set Cell padding (space around the content, but within the cell) to
5 and Cell spacing (space between the cells) to 0. Table widths can be in pixels or in
percentages (a % of the screen size). You can set the table width in pixels for a fixed
width table or in % for a flexible table. For example a table with a 75% width will be
75% of the browser window no matter how the browser is resized. If you don’t set a
table width, the table will expand to fit the content and in a browser window wiill
expand to fill the page. For today’s project, set the Table Width to 90%. If
necessary, the table properties can be changed in the Property Inspector at any
time. Also the width and height can be changed by clicking and dragging the borders.
It is not necessary to set a height for a table.

Cell Spacing

// THO1 \\“
LY

(V4
L

| _— Cell Padding

v

|

I

| ] | |
‘ H H!—bText
|

|

Sizing Handles

3 Columns
<bodys [ctabies) Ere
i v Properties I :
:j Table Id Rows ’5_ W ’W—m CelPad ’5_ Align IDeFauIt j Class INnne j
— Iﬁ Caols ’3_ H ’—m CellSpace ’T Border ’2_

@ m ﬂ Bq color E Brr colar E #990033
E M E Eg Image ‘ {25 |

10. To create the proper look for our home page, we will merge the cells in the top row

and the two middle rows in the 2" column. To merge cells, select the cells and click
on the merge cells button on the Property Inspector (or go to the Modify Menu
and choose Table=Merge cells). Make sure the table is selected and choose to
center it using the alignment bu@ns in the property inspector.

i v Properties

Format [1one =] style [ one =] s | B NeE[=|=E|=]| k] e %
FontlDeFauItF Int j SizelNc-ne jl j D| i=(i=|t=|2= Targetl "l
;—ﬁl el A Horz IDefauIt 'I W Mowrap [~ Eg | &

Wert IDefauIt 'I H Header [ Bg E| Erdr D| -
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Adding Content to a Page

1. In the first cell of your table, type the heading for the page. The Delete key, the
Backspace key and Edit=Undo all will undo actions and remove items from your page. To go
to the next line, hit the Enter key. This will create a new paragraph which will give some
white space above and below the text. If you want to go to a new line, but not create a new
paragraph, hold down the shift key and press enter. This will create a line break but not a
new paragraph.

2. To enter an image, go to the Common Insert Bar, and choose the image button (it looks
like a tree). The Image Source dialog box will open. This will show a preview of selected
images.

Select Image Source ﬂll
Select file name from: (% File system Siizs 2 Semcis,. |

" Data sources

Look ir: I_} gainesville j 0 5 Image preview

| _nokes
| ) conkent

| )images

Fils name: || 0K I

Files of tupe: |Image Files [*.gif;" jpg;" jpeg.” pna) j Cancel

LIRL: Ifile: ACDacuments and Settings/Dmillic/Desk

Relative to; I ['ocument - I practice. htm

v Preview images

3. Choose your images folder. Choose the image you want and click OK.

Your image is now on the page where the cursor (insertion point) was located. The Image can
be resized. The best practice however, is to have your picture sized properly before inserting
it into your page by using a graphics program. Alternatively, you can just find the image in
your files panel and click hold and drag the image file into place.

4. Enter an alternate text for your picture. This is a text equivalent that will display if the
picture does not load properly or if the person viewing your page does not have graphic
capabilities, or for those “reading” the page using a screen reader. This is one of the
accessibility options available, and is a good practice. Enter the description of your image in
the Alt text box in the Property Inspector. If your image has a text equivalent elsewhere
on the page, such as a caption, or if the image is purely decorative, using the Alt drop down
set the Alt attribute to <empty>.

‘| ¥ Properties

H Image, &k

|
Map Y Space | Target | j Border | % % %
,T gg m H Space | Low Src | %) Align IDeFauIt 'I

&O i

Wils0 Src | images{poesprings.jpg £ ) ’ Class I vl
[+ -
Hiizo 7 Lk 0 Edt G Sl 1) ey 0| A
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5. To direct your audience to other websites, make some hyperlinks. Type something
descriptive such as Go to the City of Gainesville website. Insert a paragraph break by
pressing the Enter key. The enter key applies a paragraph break which gives white space
above and below the text. (Remember, to move to the next line without that extra space, use
shift + Enter.)

6. Select the words “City of Gainesville”. In the Property Inspector, in the Link text box,
type in the full URL of the link for example http://www.cityofgainesville.org/ and press
the Enter key. This will enter a hyperlink in your document and will show up underlined.
Typically the color of the hyperlink is blue and Dreamweaver sets this automatically.

. il I

[ reoperics =
gEmEm Moo o wiso \%ima gadgg ) ak [Poesprings 7] dass| stylel [F] %
| H[120 Jc T | edt G| K| 1| B ©] A
Mep |  wSpace|  Tarmet Border | %%E
e OO Hspace | P it | (5 din [pefak 7] 4

~

7. The link is now a working link and that is all that needs to be done. However, in the
Target dropdown box there are choices to make the link open in a new browser. Choosing
_Blank in the target drop down will make the link open in a new browser window.

8. Press Enter to make another paragraph and repeat the hyperlink process for the remaining
links.

9. Add footer information to the page. Items such as Created by, Copyright info and a Last
Modified date for example. To add the date, place your cursor in the last cell. Then, using the
Common Insert bar, choose the Date icon. The date can be in many formats and if you
check the box on the bottom it will update automatically each time the page is saved.

10. Format the headings on the page by selecting the text and using the Format drop down
box in the Property Inspector. There are several heading options. We format the headings
to give the headings meaning. Formatting a specific heading will make the content more
meaningful to search engines and will assist screen readers.

Save and Preview your page.

8/27/2008



Styles

To make the page look better and/or more appealing, we add style to our page. We can do
this in different ways. One way is to use the property inspector and add size and color to text
or other objects on the page. A better more efficient way to add style is to use CSS or
Cascading Style Sheets. This is covered in a later workshop. Check out the handout for the
CSS class at http://training.health.ufl.edu/handouts.aspx#internet .

Look at the Page Properties by clicking on the button (labeled Page Properties) on the
Property Inspector. It will open the dialog box below and we will work on Appearance.
(Another way to access Page Properties is to go to the Menu - Modify>=Page Properties.)
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For this project we will be setting a background color for our page. Click on the small
square next to Background color. The color picker pops up and gives the option to
choose any color. Choose a color and press the Apply button. This will apply the
background to the page and show what the page will look like. You have the option of
changing it as many times as you want. This project is using color #FFFFCC. When you
have the color you want press the OK button. (Although our monitors will theoretically
display over 16 million colors, there are only 216 “Web Safe” colors. Those are the
colors that will normally look the same in Internet Explorer, Firefox, Safari or Netscape on
PC’s or Macs. Web safe colors can be recognized by the hexadecimal value. Each web
safe color will have 3 pairs of numbers consisting of 00, 33, 66, 99, CC, FF. Any time you
are picking a color, you will see the hexadecimal value displayed. The cubes in the color
picker are the 216 colors traditionally considered to be web-safe. Most current monitors
can see all 16 million colors so this is not as important as it once was.)

8/27/2008


http://training.health.ufl.edu/handouts.aspx#internet

Creating additional pages

When creating new pages, there are a couple of options. You could start the same way you
did with the first page by opening a new blank html page. Another way is to duplicate the
original page and delete what you don’t need and add the new content. One way to duplicate
the page is to open it in Dreamweaver and then use the Save As command in the File menu
giving the page a new name. Another way is to right click the page name in the files panel,
choose edit and then duplicate.

After creating the new page and giving the page a new name
o0 Delete all unnecessary information

Merge or split cells as necessary

Add content — Format as necessary (ie. H1)

Add images

Give the page an appropriate title and save

O O O0Oo

For the second page in our site we are going to add a text file (city_facts.txt) and a new
nested table to add a few pictures to the bottom of the page. The .txt file can be selected in
the files panel and dragged onto the page or it can be opened by double clicking in the files
panel and then copied and pasted into the page. Dragging files may create extra line breaks
that will need to be deleted. Copying and pasting may take an extra step, but seems to add
fewer extra spaces.

For the third page we will use an existing table of facts created in Word (services.doc).
As with the .txt file, the .doc file can be selected in the files panel and dragged onto the page
or it can be opened by double clicking in the files panel and then copied and pasted into the

page.

The last page in the site will be a map page with a rollover image. A rollover image is two
images located in the same space. One image is the base image. Then, when the mouse is
over the image the second image shows. Move the mouse and the first image takes its place
again.

1. Using your first page, create a new HTML page. Save the page. Give it a title (In the
Document toolbar). This will be our Map page. Type and format the Heading (Gainesville
Driving Directions) on the page.

2. Click to place your cursor in the proper table cell. In the Common Insert bar, click on the
small triangle next to the image button. In the drop down box, choose Rollover Image.

Insert Rollover Image

Image Mame: IIMI

Ok

Cancel

4N

Criginal Image: I Browse, .. I
Help
Rollover Image: | Browse. .. I

" preload Rollover Image

Alternake Texk: |

when Clicked, Go To LRL: | Browse. .. I

3. Use the browse buttons to locate the images. Select the images to go on the page. The
standard non-rollover picture is the Original image. Also check Preload Rollover Image to
make the image cache in the browser so the picture will load quickly. As with all images, type
in an alternate text. Click OK. Save the page and preview in the browser. Test the rollover
image to make sure the pictures swap out as the mouse rolls over the image.

4. Add the directions text in the proper cell.
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Adding a Navigation Bar

Once you have a group of web pages you want to make sure that anyone looking at the pages
can maneuver through your site at will. We will use a table to add a navigation bar.

1. Open your Home page. Insert a table with 1 row and the # of columns to match the
number of pages in your site. Use O for border, cell spacing and add 10 in cell padding.
Set the width at 90%. Click OK.

2. The table is on the page and selected. While it is still selected, use the Property
Inspector to align the table on the page by choosing Center from the Align drop down
box. If the table is not selected, it can be selected easily by clicking on the tag in the Tag
Selector on the Status bar.

3. Click in the first cell and drag your cursor through the cells to select the whole row. Click
on the Align Center button on the Property Inspector to align the contents of all the cells
to the center.

4. Type a name for each page in each cell.

5. Select the name in the first cell. Using the Point to File button in the property inspector
next to the Link text box, click hold and drag to the proper file in the file panel. The Point
to file button will automatically fill in the Link box for any file in your file panel.

i ¥ Properties \ =
Format [Paragraph =] Stvle | Nare -] s | Blz|=|g|E]E| k] @ %
Font [Defaul Fort v | size [More =[ [ =] [ 3=[:= | = [22] Target | 2|
=) el Harz ILeFt j Wl Mowrap [~ Bg | R
g E Werk ITnp j H| Header [ Bg D Brdr D N
6. Repeat the process for each page.
7. Save the page and preview it in the browser. Make sure all the links work properly. Now
we need a way to get back to the home page and move around the other pages.
8. On the Home page select the Navigation table by clicking in the table and then selecting
the table tag in the tag selector in the status bar at the bottom of the page. Copy the
table (Edit> Copy or CTRL+C). Open your other pages and paste (Ctrl + V) the table on each
of the other pages in your web site.
Another option is to use Dreamweaver’s Navigation
Bar. This requires four images for each link that are s =
exactly the same size. You need an image for Up, = B %
Over, Down, and OverDown. Once you have all four Fﬂ_ gﬁp

images prepared for each link, go to the Image insert

button and choose Navigation Bar. ——— =
Give the link an Element Name and then browse for Over mage: [Bonse...|
each image. Add the URL for the link and make sure RS (Ewoeen]
Preload Images is selected. You may want to select s i
Show “Down Image” initially for the page you are When dked, Go ta URL: s
currently working on. Decide if you want the bar to be Optons: U] preoad inages
vertical or horizontal and whether you need it to be in Sl

Insert: |Horizontally - 7| Use tables

tables. Once the first link is finished, click on the plus
to add additional links. When finished, click OK and you

will have a new Navigation Bar on your page.

When your bar is finished, you can select the Navigation Bar and paste it on each of your
other pages. Then from the Modify menu item, choose Navigation Bar and then you can
change the initial state of the button for each current page.
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Test the Site

Before you put your site on a server it is best to test it on your local machine.

1. Open your Browser (Internet Explorer, Netscape, Mozilla, etc.)

2. From the browser Menu bar choose File > Open. Locate your root folder and choose
your home page (index.htm). Your site should open in the browser.

3. Test all the links, both the links to your pages as well as the external links to other sites.
Test to make sure the email links works. (Don’t send email; just make sure it brings
up the email client.) Remember to get back to your site from other sites you may have
to use the browser’s Back button.

Post the website to a server

There are a few ways to get the website “live” and viewable by the public.

Many departments have a public folder that will allow you to copy your website in the folder
and get a URL so anyone can navigate to the website with a browser.

Another way to post the site is to use FTP. That is a File Transfer Protocol. FTP is a process
where the files are uploaded to a server and are then available for viewing.

Check with your department IT person as to how this would be done in your department.
Once you have a folder on the “live server” you can go to Site > Manage Sites to edit the
remote site information. Then use the big blue Put arrow in the files panel to upload your

files.

Many email servers allow a certain amount of space for personal websites.

Helpful Keyboard Shortcuts

Command Shortcut
Save CTRL + S
Copy CTRL + C
Cut CTRL + X
Paste CTRL + V
Clear Delete / Backspace

Another shortcut is to use the mouse right click. When you are working with an item on the
page, if you right click on the item you will get a context menu. This has many commonly
used options for that particular item.

You can create your own keyboard shortcuts.

e From the edit menu choose Keyboard shortcuts. Make a copy of the standard
shortcuts (this way if you don’t like the new shortcuts you can always get back to the
original set.

e Give the copy a new name

¢ Choose a command you would like to create a new shortcut for, for example Save All

e Choose the keys you want to use.

o If the key combination is already in use as a shortcut it will tell you and you
can choose something else.

e When you are happy with your shortcuts click Change and then OK
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